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Appendix

D

Like most programs, Photoshop groups all its commands into menus. On both 
Macs and PCs, Photoshop's menus appear at the top of your screen in the menu 
bar. Strap yourself in and hold on tight for a warp-speed tour of Photoshop's nearly 
300 menu items!

 Note  All the page numbers mentioned in this appendix refer to the printed book, not pages in this appendix. 

Photoshop
This menu, which appears only in the Mac version of Photoshop, includes items like 
information about the program, preferences, and the Quit command.

 Note  On a PC, you can find the items in this menu in the File, Edit, and Help menus instead.

About Photoshop
Select this item to see which version of Photoshop you're running and to learn the 
names of the folks who wrote the program.

About Plug-In
This option shows info about all the different plug-ins installed in Photoshop—the 
plug-ins that shipped with the program plus any custom goodies you've added.

d

 Photoshop Menu 
by Menu
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Preferences
You can check out Photoshop's preference settings by choosing this option (see 
page 29). On a PC, go to Edit→Preferences instead.

Services
Mac OS X includes a feature called Services that lets you do things like look up a word 
in the dictionary, send a chunk of text as an email message, summarize a passage 
of text, and so on. Any Service installed on your Mac shows up here. Photoshop, 
alas, doesn't support Mac OS X Services, so you can't take advantage of them when 
you're editing images.

Hide Photoshop
Hides all of Photoshop's menus, panels, and windows so you can work in other pro-
grams. (This is like minimizing the Photoshop window on a PC.) To show Photoshop 
again, click its icon in the Mac OS X Dock or press c-Tab.

Hide others
Hides every program your computer is running except Photoshop.

Show All
Reveals every program you may have hidden with the Hide command.

Quit Photoshop
Closes your open images and exits Photoshop. On a PC, you can quit Photoshop 
by choosing File→Exit.

File
The File menu is home to commands that let you open and close documents, import 
and export files, browse files in Adobe Bridge, print documents, and so on.

New
Creates a new document (page 41).

open
Lets you pick an existing document to open (page 51).

Browse in Bridge
Launches Adobe Bridge in a separate window so you can import, organize, or locate 
images you want to work with. Chapter 21 covers using Bridge.

Browse in Mini Bridge
Launches a mini version of Adobe Bridge in its very own panel at the bottom of 
your Photoshop window. This panel gives you quick access to files without having 
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to swap windows in order to see Adobe Bridge (though this command launches 
Bridge). See Chapter 21 for the scoop on using the Mini Bridge panel.

open As Smart object
Lets you open a file as a linked Smart Object in a new Photoshop document (page 
126).

open Recent
Displays a list of documents you've opened recently so you can reopen them without 
rooting through your hard drive.

Close
Closes the current document.

Close All
Closes every document you have open in Photoshop.

Close and Go to Bridge
Closes the current document and opens the full version of Bridge so you can browse 
for other images.

Save
Saves the current document to your hard drive. If you've already saved the document, 
choosing this command overwrites the previous version. (You've been warned!) If 
you haven't saved the document before, choosing this command opens the Save 
As dialog box, explained next.

Save As
Opens the Save As dialog box where you can save a copy of the current file with a 
new name or in a different format (page 48).

Check In
Earlier versions of Photoshop included a little application called Version Cue, which 
was useful if you worked and exchanged files with other folks using Adobe's Creative 
Suite. It kept track of the changes each person made to each file (technically called 
asset management), and acted like a librarian, letting you check out files when you 
needed to work on them. It also organized documents and recorded other important 
bits of information about the files you used. However, Adobe killed Version Cue in 
2010, which is why this menu item is grayed out in Photoshop CS6. 

Save for Web
Lets you save a copy of the current document in formats that work well with web 
browsers (page 723).



PhotoshoP Cs6: the Missing Manual6

File
Revert
Wipes out any changes you've made to the current document and returns it to its 
last saved state

Place
Use this option to place an image or other Photoshop-supported file format into 
your current document as a Smart Object (page 128). The artwork appears on its 
own layer, surrounded by a bounding box you can use to resize it.

Import
When you choose this menu item, you see a submenu containing options for import-
ing a variety of info into Photoshop. Here are your options:

•	 Variable Data Sets let you import files that are filled with info Photoshop needs 
to make customized images based on a template file.

•	 Video Frames to Layers lets you open a movie file's frames as individual layers 
in a new document.

•	 Images from Device lets you use a scanner to get a picture, drawing, or anything 
else off paper and into Photoshop on a Mac (see the box on page 57 for more 
on scanning). Make sure you've installed the scanner's software so Photoshop 
can communicate with it (if you haven't installed the software, you won't see 
it in the submenu)

•	 Notes lets you import annotations into your image from PDF documents.

•	 WIA Support is available on PCs running Windows and lets you import images 
from an attached digital camera, memory card, or scanner.

export
Choose this menu item to export your image as paths (page 538) so you can open 
them with Adobe Illustrator, export collected data (Photoshop CS6 Extended only), 
export a sequence of images to video (page 815), or use the Zoomify plug-in to 
protect large-sized images from being downloaded from the Web (749).

Automate
As you learned in Chapter 18, you can automate tasks you do over and over in 
Photoshop by saving them as actions. This menu item lists the built-in actions that 
come with Photoshop.

Scripts
Scripts go hand in hand with automation because they also handle repetitive or 
complex tasks for you. Photoshop's built-in scripts (like the super handy Image 
Processor—see page 251) are listed here.



 aPPendix d: PhotoshoP Menu by Menu 7

eDit
File Info
Choose this item to see info (a.k.a. metadata) about the current document, including 
when it was created, how big the image is, its name, copyright information, and so 
on. You can add and edit these details, too.

Print
Choosing this item opens the newly redesigned Photoshop Print Settings dialog 
box and lets you choose things like the number of copies, print quality, and which 
printer to use (see Chapter 16). After you get the settings just right, click Print to 
send your document to the printer.

Print one Copy
Choose this option to make Photoshop send the current document to the printer 
you normally use without giving you a chance to change any settings first. Think of 
Print One Copy as a quick-and-dirty way to print an image without encountering a 
slew of dialog boxes.

 Note  On PCs, the File menu also includes the Exit command.

Edit
This menu is where you'll find the Copy and Paste commands, Transform options 
(page 259), and keyboard and menu shortcut settings, among other items. If you 
use a PC, you'll also find Photoshop's preferences here.

Undo
Make a mistake editing your image? Use this command to erase the last thing you 
did (see page 25).

Step Forward
If you backtrack through your image edits, you can move forward through them 
again by choosing this command (page 25).

Step Backward
Step Backward works just like Undo, but you can use it to go back more than one 
step (see page 25).

Fade
This command lets you change the strength (opacity) and blend mode (page 280) 
of the last edit you performed. It works on filters, image adjustments, and so on. 
You can learn more about it in the box on page 464.
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Cut
Copies the selected item to your computer's memory and deletes the original.

Copy
Copies the selected item to your computer's memory but leaves the original intact.

Copy Merged
This command makes a merged copy of all the visible layers in a selected area. If 
you're editing a multi-layered document, this is a handy way to quickly consolidate 
and copy a certain part of the image—the area you've selected—onto a single layer 
without having to select that area on each layer.

Paste
Places objects you've copied to your computer's memory into the current document.

Paste Special
This menu item was renamed back in Photoshop CS5 (it used to be called Paste Into) 
and gives you a few different options, including pasting one selection into another 
(by choosing Paste Into). For example, if you copy a selection (an image, say) and 
then create a selection in another document (such as a picture frame, as shown in 
the figure on page 271), you can use this command to make Photoshop paste the 
contents of that first selection into the second one, complete with a layer mask. The 
other commands listed here are "Paste in Place" and Place Outside. Page 270 has 
the scoop on these new commands.

Clear
This command deletes whatever you've selected from the active layer.

Check Spelling
If you add text to your image, this command checks it for spelling errors (see the 
box on page 599).

Find and Replace text
This command lets you find specific words or phrases in your document and (if you 
like) replace them with different text (page 598).

Fill
This command fills the selected area with the color of your choice. If you haven't 
selected anything, it fills the whole layer instead.

Stroke
This command adds a colored stroke, or outline, to your current selection.



 aPPendix d: PhotoshoP Menu by Menu 9

eDit
Content-Aware Scale
This feature lets you change the size of an image without distorting the important 
parts, like people—see page 254.

Puppet Warp
This command lets you twist and turn, move and distort pixels independently of 
other pixels in an image. By placing markers (called pins) on the object you want to 
move, Photoshop creates a mesh behind it that you can move the object along. It's 
discussed in step-by-step glory on page 448.

Free transform
This command lets you scale, stretch, warp, distort, and rotate the selected object 
(see page 259).

transform
Transform works like Free Transform but lets you change only one aspect of the 
selected object at a time. For example, you can rotate the object, but can't scale it 
at the same time. See page 259 for more info.

 Note  The Free Transform and Transform features work on individual layers (as many as you've activated), 
not on your entire document.

Auto-Align Layers
This command makes it easy to create panoramas from a group of similar images. 
When you run it, Photoshop looks for the common elements in each photo and aligns 
them automatically (see page 295).

Auto-Blend Layers
This option lets you combine the best parts of similar images into a single image; 
Photoshop creates all the necessary layer masks for you. Page 299 has the details.

Define Brush Preset
Choose this option to convert the selected object into a custom brush (page 527).

Define Pattern
This item makes a custom pattern out of your current selection (see the box on 
page 96).

Define Custom Shape
This option turns the selected path or vector mask into a custom shape (page 555).
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Purge
This item lets you clear Photoshop's undo list, the items you've copied to your com-
puter's memory (including its video cache), or the edits Photoshop has recorded as 
history states. You can also choose to clear all three at once.

Adobe PDF Presets
This item lets you manage, edit, and add groups of settings you can use when mak-
ing PDF versions of images. Chapter 16 has more about using and working with 
documents in PDF format.

Presets 
You can manage groups of custom brushes, patterns, shapes, colors, and styles by 
selecting this menu item, which lets you edit or combine groups into new libraries 
as well as delete groups. Page 38 has the scoop on working with presets.

Remote Connections
This command lets you allow a wireless device or other program to connect with 
Photoshop. 

Color Settings
This item brings up Photoshop's advanced color settings so you can control color-
management and device profiles (see page 674).

Assign Profile
This option is part of Photoshop's color-management system. From here, you can 
assign specific color profiles to individual documents or disable color management 
(discussed in Chapter 16, beginning on page 674).

Convert to Profile
This option lets you change an image's color-management profile (see Chapter 16).

Keyboard Shortcuts
Choose this item to customize Photoshop's keyboard shortcuts, add your own, and 
save your personalized menu commands to share with other folks (see the box on 
page 37).

Menus
Choose this option to see all of Photoshop's menus and, if you like, tweak them (see 
the box on page 37).

 Note  In the Windows version of Photoshop CS6, the Preferences option appears at the bottom of the Edit 
menu.



 aPPendix d: PhotoshoP Menu by Menu 11

iMageImage
This menu groups together features for working with images and your canvas. You 
can resize documents, adjust Curves and Levels, duplicate images, and rotate im-
ages from here.

Mode
This is where you change the current document's color mode (page 45) and bit depth 
(see the box on page 46). You can choose from Bitmap, Grayscale, Duotone, Indexed 
Color, RGB, CMYK, Lab, and Multichannel color modes and 8-, 16-, and 32-bit images.

Adjustments
From here, you can change the colors and overall tonal quality of your image. Chapter 
9 has the full scoop on correcting images without harming your original.

Auto tone
This command analyzes the current image and tries to adjust its overall colors to 
make it look better. Flip to page 355 to learn more about fixing color in images.

Auto Contrast
This command adjusts the contrast between light and dark areas in your images 
so that highlights look brighter and shadows look darker. Check out page 356 to 
learn more.

Auto Color
Artificial lighting can skew the colors in images, so use this command to shift them 
back so they look more natural. Page 353 shows how you can use this command to 
instantly zap a color cast.

Image Size
This option lets you change your image's resolution and dimensions. This dialog box 
is discussed at length in Chapter 6, beginning on page 238.

Canvas Size
Choose this option to change your document's dimensions without changing its 
file size or resolution. Use this command if you need more space in a document but 
don't want to resize its content.

Image Rotation
Use this item's options to rotate your image and canvas. You can choose one of the 
presets—like 180° or 90° CW (clockwise)—or choose Arbitrary and then enter the 
number of degrees you want to turn the image.
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Crop
This command lets you remove the edges of an image in order to produce a more 
visually pleasing composition or change its size. Photoshop keeps the area inside the 
crop box and removes everything else, leaving you with an image that's physically 
smaller than it was before. See page 220 for more on cropping.

trim
Like Crop, this command lets you trim away the edges of an image based on the 
color in each corner or on transparent pixels. This command is incredibly handy 
when you need to produce the smallest image possible for, say, use on the web or 
in a book (see page 230).

Reveal All
This command shows you all your image's hidden edges if you've cropped non-
destructively (page 224).

Duplicate
Makes a copy of your current document and lets you give the duplicated document 
a new name.

Apply Image
This command lets you combine a layer and channel from one document with a 
layer and channel from another document using the blend mode and opacity of 
your choice (see page 213).

Calculations
This command works a lot like Apply Image, but instead of combining layers and 
channels, it combines only channels; see page 215 in Chapter 5 for more info.

Variables
This menu item lets you designate areas of a document as placeholders for other 
images or text that Photoshop adds automatically from a specified data source (see 
the next item). It lets you create powerful document templates that you can use to 
generate several versions of the same basic design (with different images and/or 
text) automatically. See this book's Missing CD page at www.missingmanuals.com 
for more about how this feature works.

Apply Data Set
Once you've created a document template containing variables, you can choose 
this menu item to tell Photoshop where the variable data—the other images and/
or text—lives so it can automatically create the various versions of the document.

trap
This command lets you set the spread of objects in your images, which controls 
how much colors overlap where they intersect. This setting is important in offset 
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printing. Chapter 16 has more about preparing images for an offset press, starting 
on page .691.

Analysis (Photoshop CS6 extended only)
This menu appears only in the Extended version of the program, and it includes 
tools for analyzing data in scientific images, counting objects, setting data points, 
and recording measurements. Most folks don't need these tools, but they're really 
handy if you work in scientific research or forensic analysis. Two resources for learning 
more about Photoshop's analysis features are Photoshop CS3 Extended: Research 
Method and Workflows and Photoshop CS3 Extended for BioMedical Research, both 
of which are videos available for a fee from www.Lynda.com. Even though they cover 
CS3, they still offer great info about these tools. Here's what each of the options in 
this item's submenu let you do:

•	 Set Measurement Scale. Use this option to tell Photoshop what scale to use 
when it counts. The default is one pixel equals one pixel, but you can change 
it to account for your image's scale. If, say, one micron in your image fills the 
space of 50 pixels, you can set Photoshop's scale to match.

•	 Select Data Points. Use this option to tell Photoshop what kind of info you want 
it to record when it counts. The program records all the data types you select 
in the Measurement Log.

•	 Record Measurements. Choose this command to see the Measurement Log 
panel, where Photoshop displays all the data it collects from your image.

•	 Ruler tool. You can use this tool to measure items in an image (page 71). Click 
and drag across an object and its measurements appear in the Options bar 
and Info panel.

•	 Count tool. This tool helps you tally up the number of items in an image. You 
can click objects to count them manually, or Photoshop can do its best to count 
them for you.

•	 Place Scale Marker. Use this tool to add a symbol to your image so people can 
tell what scale it's in. Be sure to set your measurement scale, as noted above, 
if you're using this tool.

Layer
This menu, not surprisingly, has controls for working with layers. From here you can 
add and delete layers, create layer masks, and merge layers, among other things. 
Chapter 3 has the complete lowdown on layers.

New
This command adds a layer or layer group to your image.

http://www.Lynda.com
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Duplicate Layer
This option does just what its name implies: Makes a copy of the current layer.

Delete
Choose this item when you want to delete a layer. You can do the same thing by 
activating a layer and then pressing the Delete key (Backspace on a PC). 

Rename Layer
This option highlights the name of the currently active layer in the Layers panel so 
you can rename it. In Photoshop CS6, you can press the Tab key to highlight the 
name of the next layer down, or Shift-Tab to highlight the name of the next layer up.

Layer Style
Go here to set the current layer's blending options and apply effects like drop shad-
ows, glows, and gradient overlays. Page 131 in Chapter 3 has more about layer styles.

Smart Filter
This option lets you delete or disable a Smart Filter mask. Chapter 15 has the scoop 
on using Smart Filters, starting on page 634.

New Fill Layer
Go here to create a layer and tell Photoshop whether if you'd like to fill it with a solid 
color, gradient, or pattern (see page 93). The neat thing about Fill layers is that, 
when you change canvas size, Photoshop automatically fills in the extra space with 
the color, gradient, or pattern you picked.

New Adjustment Layer
This option creates a new Adjustment layer so you can apply nondestructive changes 
to your images. Adjustment layers are defined on page 77, and they're used exten-
sively throughout Part 2 of this book.

Layer Content options
As of this writing, this menu item seems to be permanently grayed out so you can't 
choose it. In Photoshop CS5, you could use this option to change an Adjustment 
layer's settings. In CS6, just double-click the Adjustment layer's thumbnail in the Lay-
ers panel and the new Properties panel opens, which contains those same settings.

Layer Mask
From here you can show, hide, delete, and apply layer masks (page 116).

Vector Mask
This option is like Layer Mask item above, but it lets you work with vector-based 
objects (page 572) instead.
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Create Clipping Mask
This command lets you attach layers to one another so the content of one layer shows 
through the shape of what's on the layer below. You can learn more about clipping 
masks in the box on page 126 and see one in action on page 627

Smart objects
This menu item includes tools for working with Smart Objects—editing them, dupli-
cating them, and so on. See page 126 to learn about Smart Objects.

Video Layers
This item lets you add, remove, and paint video layers, as discussed in Chapter 20. 
You can also use this item's options to restore video frames, manage color, edit video 
and animation layers, and set when video layers appear in a timeline.

Rasterize
This command converts text, vector-based objects, Smart Objects, shapes, 3-D 
objects, and video frames into raster-based objects. The box on page 52 explains 
the difference between raster and vector objects.

New Layer Based Slice
This item adds slices for Web layouts to the currently selected layer based on its 
content; see Chapter 17 for details.

Group Layers
Use this command to group active layers together. The layers will appear in their 
own folder in the Layers panel (see page 108).

Ungroup Layers
This command removes layers from a group and deletes the group (but doesn't 
delete the layers).

Hide Layers
Use this command to hide layers or layer groups temporarily so you can see and 
work with objects in complex images; it's the equivalent of turning off a layer's vis-
ibility icon (see page 84). 

Arrange
This item lets you change the order of layers and layer groups in the Layers panel.

Combine Shapes
New in Photoshop CS6, this menu item lets you combine and intersect objects on 
Shape layers that you've drawn using Photoshop's built-in Shape tools (see page 550).
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Align
This option lets you align content that lives on different layers; page 100 has the 
scoop.

Align Layers to Selection
Also new in CS6, this menu item lets you align content on multiple layers to an ac-
tive selection (marching ants).  

Distribute
This item aligns the contents of three or more layers along the object's edges or 
center points (see page 102).

Lock Layers/Lock All Layers in Group
This command lets you lock the activated layers, or lock all the layers in a group so 
you don't accidentally edit or change them (page 108).

Link Layers
Use this command to hook layers together so they move as if they were a single 
layer. You can still edit linked layers, and you can unlink them, too (see page 106).

Select Linked Layers
Choose a linked layer and then pick this menu item to activate all the layers linked to it.

Merge Layers
This command combines the active layers or layer groups into a single layer (page 
113).

Merge Visible
Use this command to combine all your image's visible layers into a single layer 
(page 114).

Flatten Image
This command merges all your image's layers into the Background layer.

Matting
This option removes the extra pixels surrounding an object's edge after you've 
isolated it from its original background. After you apply matting, the item's edge 
should look cleaner and more natural. See Chapter 4 for more on making and edit-
ing selections.

Type
New in CS6, this menu houses commands related to text that were previously 
sprinkled throughout Photoshop's menus and preferences.
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Panels
This menu item gives you access to Photoshop CS6's new Character Styles and 
Paragraph Styles panels. See the box on page 613 for more info.

Anti-Alias
Use this option to control how much blurring occurs on the edges of text to make 
the letterforms smoother (or, if you like, less smooth); see page 609. 

orientation
This menu lets you switch between horizontal (left-to-right) and vertical (top-to-
bottom) text.

opentype
This handy menu item gives you fast access to the extra formatting goodness con-
tained in some OpenType fonts. Flip to page 609 for more info.

extrude to 3D
Available only in Photoshop Extended, this command creates a new 3-D object 
from the selected text.

Create Work Path
Use this command to create an editable path out of the active Type layer, which lets 
you change the shape of individual characters. See page 557 for more on working 
with paths.

Convert to Shape
This command creates a Shape layer out of an active Type layer, as explained on 
page 630.

Rasterize type Layer
This command converts a vector-based Type layer into un-editable pixels.

Convert to Paragraph text
This command converts point text (the kind that can dangle off the edge of your 
document) to paragraph text (a text box) and vice-versa (see page 584).

Warp text
Use this command to summon a dialog box that lets you reshape text in a variety 
of ways. Page 597 has the scoop.

Font Preview Size
Previously buried deep within Photoshop's preferences, this command lets you 
change the size of font previews visible in the Fonts menus that live in the Options 
bar and Character panel (see page 582).
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Language options
This menu gives you access to the special features of East Asian languages.

Update All text Layers
Opening a Photoshop document containing text created in an earlier version of the 
program can sometimes cause the text to reflow. This command lets you update 
all the layers in a document to the current version of the program. See the box on 
page 590 for more info. 

Replace All Missing Fonts
Use this command to replace all the missing fonts in a document with a different 
font. The box on page 590 has additional info.

Paste Lorem Ipsum
As explained in the Note on page 584, this command pastes a chunk of placeholder 
text into the active Type layer. 

Select
The items in this menu let you grab layers, pick colors, use Quick Mask mode, and 
more.

All
This command places marching ants around the perimeter of your document and 
grabs everything on the currently active layer.

Deselect
Use this command to get rid of the marching ants and deactivate a selection.

Reselect
If you didn't mean to get rid of a selection, use this command to reactivate the last 
selection you created.

Inverse
Choose this item if you select an area and want to flip-flop the selection to select 
the part that's not selected (page 141).

All Layers
This option activates all the visible layers in the Layers panel so you don't have to 
activate 'em one at a time.

Deselect Layers
Choose this option to deactivate the currently active layers.
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Find Layers
New in Photoshop CS6, this menu item activates the layer filter tool at the top of the 
Layers panel. You can learn all about this handy new feature on page 80. 

Color Range
Use this command to open a dialog box that lets you select areas in your image 
based on color (see page 157).

Refine edge
This command opens a dialog box that lets you fine-tune the edges of a selection, 
which is especially helpful when wispy bits like hair or fur are involved. You can learn 
all about it on page 171.

Modify
This option lets you tweak the edge of your current selection by expanding or shrink-
ing it, feathering it, grabbing just its border, or smoothing it.

Grow
This command finds and grabs pixels that match the colors around the area you've 
selected. (The pixels have to be adjacent to your selection—see page 156.)

Similar
Like the Grow command, this option finds all the pixels in your image that match the 
selected area's colors, but it finds similar-colored pixels anywhere in your image.

transform Selection
This command lets you resize the currently selected area with a bounding box (just 
like Free Transform). You can see it in action on page 178.

edit in Quick Mask Mode
This option temporarily covers your image with a red overlay, or mask, letting you 
create or fine-tune a selection visually (see page 181).

Load Selection
This command lets you activate a selection you previously saved so you can use it 
again (see page 184).

Save Selection
Use this option to save a selection for future use (page 184).

New 3D extrusion
Found only in Photoshop Extended, this command lets you create a new 3-D extru-
sion from an active selection.
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Filter Filter
This menu is packed with all kinds of effects you can apply to images. It groups 
filters by type: Artistic, Blur, Sharpen, and so on. Chapter 15 covers filters in detail. 

 Note  In CS6, Adobe shortened the Filter menu by removing items that can be triggered from the Filter 
Gallery. See the box on page 637 for instructions on repopulating your Filter menu so it matches the items listed 
here.

Last Filter
This command applies the last filter you used—with the same settings—to the cur-
rent layer or object.

Convert for Smart Filters
Use this feature to convert a regular layer to a Smart Object so you can use Smart 
Filters (see page 634).

Filter Gallery
Choose this option to see a preview of how your image will look if you apply various 
filters. It's available for several filter categories, and it's a good way to learn how 
those filters affect your image (see page 637).

Adaptive Wide Angle
New in CS6, this filter lets you easily fix distortion problems common when shooting 
with a wide-angle or fish-eye lens (see page 636). 

Lens Correction
Not only does this filter let you add a beautifully darkened edge vignette (page 641), 
it can also correct all manner of lens distortion, as described in the box on page 642 

Liquify
This filter lets you push, pull, and move pixels in all sorts of ways in order to change 
reality (page 428).

oil Paint
New in CS6, this filter lets you create a painting from a photo by tweaking a series 
of sliders. You can see this filter in action on page 643.

Vanishing Point
This filter helps you maintain an image's perspective while you paint, clone, or add 
other images to it. See page 644 for the step-by-step scoop.
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Artistic
This category includes filters that make images look like a painting or drawing 
(page 649).

Blur
These filters change the focus in all or part of an image (page 649). In CS6, this menu 
gives you access to the three new filters—Field Blur, Iris Blur, and Tilt-Shift—that are 
useful for creating shallow-depth-of-field effects after you take the photo. You can 
learn all about these new filters in Chapter 15, starting on page 652.

Brush Strokes
The filters in this category make your image look like it was painted, penciled, or 
spray painted, among other effects; see page 660 for details.

Distort
These filters create geometric patterns based on your image, including ripple, twirl, 
and zigzag effects (page 662).

Noise
This category includes filters that can help smooth areas of an image that don't 
blend well, fix dust and scratches in photos, and remove graininess (page 662). 
You can also use these filters to add grain to give an image more texture and depth.

Pixelate
These filters convert images or selections into groups of geometric shapes and 
patterns (page 662).

Render
These filters let you add cloud patterns, fiber patterns, and lens flares, and adjust 
an image's lighting (page 662).

Sharpen
You can use filters in this category to make blurry or out-of-focus images clearer 
(see Chapter 11).

Sketch
These filters let you add artistic effects to make images look like they were hand 
drawn with charcoal, conté crayons, graphic pens, and so on (page 664).

Stylize
These filters accentuate the edges in an image in order to do things like turn images 
into collections of blocks or dots, a pencil sketch, or add a wind-blown look (page 
666). You can use the Emboss filter in this category to sharpen a blurry image (see 
page 668).
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texture
These filters make an image look like it's on a textured surface such as tiles or stained 
glass (page 669).

Video
These filters let you deinterlace (smooth) images that you've grabbed from videos, 
and restrict images to colors that display properly on TVs in the United States 
(NTSC-safe colors).

other
This catch-all category includes options that let you build your own custom filters 
and adjust a layer mask's size, among other things. Page 671 has more info.

Digimarc
These filters let you add a watermark and copyright info to images (see page 746).

Browse Filters online
This option fires up your web browser and takes you to the Adobe website so you 
can browse and download even more filters.

3D (Photoshop Extended only)
The items in this menu pertain to creating 3-D objects in Photoshop, which is beyond 
the scope of this book. To learn more about 3-D in Photoshop, visit this book's Miss-
ing CD page and look under the Chapter 3 heading. 

View
This menu gives you all sorts of different ways of looking at images, from zooming 
in or out to adding guides and rulers. (See Chapter 2 for more document-viewing 
options.)

Proof Setup
Use the items in this submenu to create a proof, a sample version of your image 
that simulates what the finished piece will look like. You can simulate how your im-
age's colors will look on a Mac or PC monitor or in another color mode—even how 
a color-blind person would see them. This preview process, called soft proofing, is 
discussed in more detail in Chapter 16.

Proof Colors
This option turns soft proofing on or off (see page 706).
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Gamut Warning
Turn this feature on to make Photoshop highlight areas of your image that fall outside 
of the safe color range, or gamut, for the color mode you're working in.

Pixel Aspect Ratio
This item lets you change the shape of your image's pixels for specific projects. 

Pixel Aspect Ratio Correction
Turn this feature on when you're working with pixels that aren't square so your im-
ages don't look stretched when viewed on your computer monitor.

32-bit Preview options
Because the dynamic range in 32-bit HDR images is greater than the color range 
most monitors can display, this option compensates for washed-out highlights and 
overly dark shadows. To learn more about HDR photography, see page 398.

Zoom In
This command works like a magnifying glass, increasing your image's magnification 
level (see page 60).

Zoom out
This command decreases your image's magnification level.

Fit on Screen
This option adjusts your view of the current image and the window it's in to fill your 
screen.

Actual Pixels
Select this option to see your image at its actual size.

Print Size
This item changes the size of your image to show how big or small it will be when 
you print it. See Chapter 6 and Chapter 16 for more on resizing images for printing.

Screen Mode
This submenu lets you choose how you want to view images. Page 15 shows your 
options.

extras
With this option turned on, you can add alignment helpers like guides and grids to 
your images. (If you use one of these features, Photoshop automatically turns on 
Extras for you.) Page 69 has the details.
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Show
This submenu lists the extra items you can display and use while you're editing im-
ages: guides, layer edges, notes, and more.

Rulers
This command shows or hides the horizontal and vertical rulers that run along the 
document window's left and top edges (see page 69).

Snap
Choose this item to turn snapping on or off. (Snapping lets you align objects with 
guides and other items, as page 70 explains.)

Snap to
Here's where you choose which items objects snap to: guides, grids, layers, slices, 
document bounds, or all of those things.

Lock Guides
This command prevents you from accidentally moving guides you've added to an 
image (page 70). If you've already locked your guides, choose this command again 
to unlock them.

Clear Guides
Choose this option to get rid of all the guides you've added to the current document.

New Guide
Lets you add vertical and horizontal guides to an image.

Lock Slices
Choose this item to keep your image slices (page 738) where they are.

Clear Slices
Removes all the slices from the current image.

Window
Use this menu to change what you see in Photoshop. It lets you arrange open docu-
ments, view or hide panels, and so on.

Arrange
This submenu has commands for organizing your open document windows. From 
here, you can do things like open and close panels, set the same magnification level 
across all your documents, minimize windows, and bring all your documents in front 
of other windows.
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Workspace
The items in this submenu rearrange Photoshop's panels, menus, and tools to make 
it easier to perform certain tasks like painting or working with text. Page 21 explains 
workspaces and why you may want to use 'em.

extensions
Look here for a list of the Photoshop extensions installed on your machine, like the 
collaborative, online color-scheme generator called Kuler (page 489).

3D (Photoshop extended only)
Choose this item to make Photoshop Extended display the 3D panel.

Actions
Choose this option to open the Actions panel, where you can see a list of the actions 
that came with Photoshop and ones you've created. You can also use this panel to 
manage actions, as explained in Chapter 18.

Adjustments
This panel lets you add Adjustment layers that you can use to nondestructively alter 
an image's color and lighting.

Brush
This panel lets you select and edit Photoshop's built-in brushes, as well as brushes 
you've created yourself. Chapter 12 teaches you more than you ever wanted to know 
about the Brush panel.

Brush Presets
This panel lets you view a painting sample, as well as edit and store your own cus-
tomized settings for brushes.

Channels
This panel shows the different color channels contained in your document. Chapter 
5 has the skinny on channels.

Character
The Character panel is where you can find all sorts of settings for working with text. 
See Chapter 14 to learn all about it.

Character Styles
New in CS6, this menu item lets you save and apply character text formatting op-
tions. See the box on page 613 for more info.

Clone Source
This panel groups together settings for using the Clone tools (see page 300).
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Color
Use this panel to view and change your foreground and background colors (page 
496).

Histogram
This panel includes a graph (called a histogram) that shows you information about the 
pixels in your image. Turn to page 375 in Chapter 9 to learn how to read histograms.

History
The History panel displays a timeline of the edits you've made to the current docu-
ment. It also shows what the image looked like last time you saved it and lets you 
restore the image to any previous state. See page 25 for details.

Info
This panel includes info about where your cursor is, the color of the pixels it's hov-
ering over, and the size of your current selection (if you have one). Page 385 has 
more about this panel.

Layer Comps
Use this panel to view and organize groups of layers you can use to show different 
versions of your image in a single document (see page 110).

Layers
You can add, delete, and organize your document's layers from this panel. (Chapter 
3 is all about layers.)

Measurement Log (Photoshop extended only)
This is where you can see data collected by the Count tool (see online Appendix C). 

Navigator
This panel lets you change how much you're zoomed in on an image and which part 
of the image you're viewing (see page 64).

Notes
You can view, edit, and delete notes from this panel (see online Appendix C).

Paragraph
This panel lets you control the paragraph-wide settings for text in your documents 
(see page 612).

Paragraph Styles
New in CS6, this panel lets you create and apply paragraph formatting options. See 
the box on page 613 for more info.
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Paths
You can keep track of all the paths in your image with this panel. You can also use 
it to change the stacking order of the paths as well as add and delete them. See 
Chapter 13 for more on paths.

Properties
New in CS6, this panel lets you tweak the settings for Adjustment layers as well as 
pixel- or vector-based layer masks (see page 123). 

Styles
You can use this panel to apply Photoshop's built-in styles to your images (page 
135), as well as create and save your own custom styles.

Swatches
Here's where you can view and pick colors from libraries of color chips. Photoshop 
includes a long list of popular libraries including several Pantone, Toyo, and Trumatch 
color groups.

timeline
This command opens the Timeline panel (named Animation in previous versions of 
the program) that you can use to create a frame-based animation (see page 731) 
or a video project complete with multiple clips, transitions, audio, and more (see 
Chapter 20).

tool Presets
If you regularly use the same settings for a particular tool, use this panel to save 
them as a preset so you can use them again later. Chapter 1 has more about work-
ing with presets.

Application Frame (Mac only)
Mac users can choose this item to turn Photoshop CS6's Application Frame on or 
off (page 11).

options
This menu item shows or hides the Options bar (page 13).

tools
Choose this option to show or hide the Tools panel (page 22). You'll work with this 
panel all the time, so you'll probably want to leave it visible.

open Documents
The bottom portion of the Window menu doesn't actually have a label, but it's where 
Photoshop lists all the documents you have open (in alphabetical order).
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helP Help
If you don't know how to do something in Photoshop, you may find the answer in 
this menu. It includes a link to Adobe's online help system, several tutorials, and op-
tions for activating and deactivating your copy of Photoshop (see online Appendix 
A). You need an active Internet connection to use almost every item in this menu.

 Note  In the Windows version of Photoshop CS6, this menu also includes the About Photoshop and About 
Plug-In items described earlier in this appendix.

Search (Mac only)
Can't find a menu item? Mac users can use this field to type the name of a command 
and have Photoshop automatically highlight that command wherever it lives within 
the program's menu system. 

Photoshop online Help
Here's where you can access Photoshop's online help system (see online Appendix 
B), but you need an active Internet connection. (That being said, you can download 
the help file to your computer as a PDF!)

Photoshop Support Center
This command launches the online Adobe Community Help program. You need an 
Internet connection and your Adobe ID to use it. 

Legal Notices
Yes, Adobe dedicated a menu item to Photoshop's laundry list of patents and other 
legal info. It's fun reading if you're into that kind of thing.

System Info
When you choose this item, Photoshop generates a report that lists facts like which 
OpenGL components your video card supports (see the box on page 64), which 
version of Photoshop you're using, and which plug-ins you've installed.

Complete/Update Adobe ID Profile
Use this option to complete and/or update the information associated with your 
Adobe ID. (To learn more about installing Photoshop, see online Appendix A).

Deactivate
The name of this item depends on whether you've activated your copy of Photoshop. 
If you haven't, it's called Activate; if you have, it's Deactivate. Online Appendix A 
has info about activating and deactivating Photoshop. (You need an Internet con-
nection to choose this item.)
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Updates
Choose this option to make Photoshop check for updates (see online Appendix A).

Photoshop online
Choose this item to open your web browser and head to Adobe's main Photoshop 
web page.

Photoshop Resources online
This command opens your web browser and loads Adobe's downloadable content 
page where you can find add-ons like extra filters and actions.

Adobe Product Improvement Program
This option summons a dialog box that lets you submit feedback to Adobe so it can 
make changes to future versions of the program.


